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1 GENERAL INFORMATION 

1.1 General Warnings 

Important This Instruction Manual is an integral part of the machine, it should be carefully 

read before carrying out any operation and it should be kept for future references. 

The operators shall adopt the safety precautions required by the country where 

the product is installed. 

This Instruction Manual is realized in accordance with the Directive 2006/42/CE. 

 

1.2 Generalities 

STI S.r.l. products are conceived, manufactured and controlled according to the Quality management System 

in compliance with EN ISO 9001 International Standard. 

 

1.3 Manufacturer 

With respect to Machinery Directive 2006/42/EC, the Manufacturer of the described FasTrak Compact is STI 

S.r.l. as specified on the label. 

 

STI S.r.l. Via Dei Caravaggi 15 
24040 Levate (BG) Italy 
Tel. +39 035 2928.2 
Fax +39 035 2928.247 
imisti.sales@imi-critical.com 

 

1.4 Terms and conditions  

STI S.r.l. guarantees each single product to be free from defects and to conform to current goods 

specifications. The warranty period is one year from the date of installation by the first user, or eighteen 

months from the date of shipment to the first user, whichever occurs first. 

The warranty does not cover special products or components not covered by warranty in their turn by 

subcontractors. No warranty is given for products which have been subject to improper storage, improper 

installation, misuse, corrosion, or which have been modified or repaired by unauthorised personnel: it is not 

advisable that customer or end users modify the device characteristics. 

 

1.5 Manufacturer’s liability  

STI S.r.l. declines all liability in the event of:  

- use of the device in contravention of local safety at work legislation; 

- incorrect installation, incorrect maintenance, disregard or incorrect application of the instructions 

provided on the FTC nameplate and in this manual;  

- modifications or repairs without STI S.r.l. authorisation;  

- work done on the unit by unqualified or unsuitable operators. 

  

mailto:imisti.sales@imi-critical.com
mailto:imisti.sales@imi-critical.com
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It is operators’ responsibility to comply with all applicable safety rules and to ensure that the local health and 

safety regulations are adhered to. Depending on the specific working conditions, additional precautions may 

be requested. 

Please inform STI S.r.l. urgently if you face unsafe situations not described in this Instruction Manual. 

 

1.6 Applicable Standards and Directives 

- EN ISO 12100:2010 Safety of machinery - General principles for design - Risk assessment and 

risk reduction 

- 2006/42/EC Machinery Directive 

- 2014/68/UE Pressure Equipment Directive (PED) 

- 2006/95/EC Directive for Low Voltage Equipment (LV) 

- 2004/108/EC Directive relating to the Electromagnetic Compatibility (EMC) 

- 2014/34/CE Equipment used in potentially explosive atmospheres (ATEX) 

 

1.7 Symbology used 

 

Important 

Be careful where these symbols are shown, they indicate a potentially hazardous 

situation and they warn that if the steps are not properly performed, may result 

causing serious injury, death or long-term risks to the health of exposed persons 

   

GENERAL DANGER DANGER POWER SUPPLY CRUSHING HAZARD 

 

Important 

The operators shall adopt the safety precautions required by the country where 

the product is installed. 

The operators shall also adopt the following precautions. 

      

Must wear 
protective 
clothing. 

Must wear 
protective 

gloves. 

Must wear 
protective 
footwear. 

Must wear 
protective 
helmet. 

Must wear 
protective 
glasses 

Must wear 
earplugs 
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2 Installation 

2.1 Software installation 

- Insert the CD (or download the installation file); 
- Run setup.exe; 
- Follow the instructions on the screen. 

 

2.2 Connections 

Connect your HART interface to the same connectors as the 4-20mA input signal (XT1/L+ and L-). 

Figure 1: FTC electrical connection 

 

Warning 

 

If the 4-20mA signal generator is not HART-compliant, then communication problems 
may occur. 

 

Connect the ‘FTx positioner connection cable’ to positioner connector X4. 
 

Warning 

 

X4 connection facilities can only be used in a non-hazardous area provided that:  
- Only the special ‘FTx positioner connection cable’ is used; 
- The laptop is battery-powered or is powered by a power supply unit complying with IEC 
60950-1 with Maximum Output Voltage (Um) ≤ 30V. 
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2.3 Starting the Software 

Run the software starting from the desktop icon or from the Windows Start menu. The ‘Select Communication’ 
page is displayed: 
 

- Select the right communication port (only the 
available communication ports are displayed in 
the combo box); 
 

- Select the Communication mode (RS232 or 
HART MODEM); 
 

- Click on ‘OK’ button. 
 
 
 
 
 
 
 
 
 
Then, the ‘Device Selection’ page appears: 
 

- Select the correct positioner installed (FT or FTC 
Smart Positioner); 
 

- Select the type of actuator (Single or Double 
Effect); 
 

- Click on ‘OK’ button. 
 
 
 
 
 
 
 
 
 
  

Figure 2: Select Communication Page 

Figure 3: Device Selection Page 
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3 Remote Control 

3.1 Remote Control – Main features 

3.1.1 Quick Buttons 

- Download button: downloads all the parameters from the FTC positioner. At the end of the 
download the displayed values are the same as the positioner; 

- Graph button: opens the Graph window; 
- Password button: opens the Login window. In order to change the parameters or to access 

configuration windows, a login is required. The default standard password is: 12345. 
 

 
  

Figure 5: Download button, Graph button, Password button 

Figure 4: Main features 
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3.1.2 System Setup area: Travel Control and Tuning Setup 

General definitions: 
- Limit: when a limit is configured, the Requested position is limited to this value (example: if the 

Limit is set at 95%, even if the signal input is 20mA, thus the Requested position would be 100%, 
the Requested position can’t exceed the 95%); 

- Cutoff: when a cutoff is configured, if the Requested position fall inside the Cutoff area, then the 
Request position is fixed at the min (or max) value (example: Set the cutoff at 5%; when both the 
Requested position and the Actual position are less than 5%, a fixed pressure is applied in order 
to set the actual position to 0%); 

- Cutoff (open/close) pressure: it defines the applied pressure when a cutoff is active (Advanced 
parameter); 

- Open/Close: information related to ‘Signal Fail Action’ configuration. 
 

Important 

 

The Signal Fail Action setting informs the Positioner about what happens when the 
electrical power supply fails. This behaviour is determined by the pneumatic connection 
and is not configurable through software. 

 

Important 

 

With some type of valves, it is mandatory to enable the cutoff to ensure the full trust on 
seat. 

 

Important 

 

Many parameters are configurable with different settings for the open and close directions. 
This is to maximize the performance of the system. If the Mono flag is checked then the 
first value of each parameter is automatically copied into the second one. 

 
Travel control: 
- Open Limit [50 ... 100 %]: specify if a Limit or a Cutoff is configured in the open direction; 
- Close Limit [0 ... 50 %]: specify if a Limit or a Cutoff is configured in the close direction. 
 
Tuning: 
- Kp [0,1 ... 25]: the proportional gain is the multiplier of the error (difference between the set-point 

and the actuator position - it is expressed in percentage) and it is active only if the error exceeds 
the dead band value. A different gain for each movement direction can be selected; 

- Ti [10 … 100000 ms]: the integral term helps to reach the set-point quicker and eliminates the 
residual steady-state error that occurs with a proportional-only controller. However, since the 
integral term depends on the accumulated errors from the past, it can cause the setpoint overshoot. 
The smaller the integral term value, the more aggressive the integral effect. A different integral 
factor for each movement direction can be selected; 

- Td [0 ... 1000]: the derivative term slows the rate of change of the controller output. Setting Td 
equal to 0 disables the derivative factor. Increasing its value makes the derivative action more 
effective; 

- Dead Band [0 … 10]: in a steady-state condition, dead band can be used to reduce continuous 
cycling (“hunting”) around the target position. Increasing its value reduces the accuracy, but it can 
improve stability; 

- Velocity Limit [0 ... 655 s]: velocity limit is the maximum speed value (expressed in number of 
seconds to travel the whole stroke) the actuator can travel. A different velocity limit for each 
movement direction can be selected; 
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- Damping Factor [0 ... 255]: applies a damping effect to the set-point rate of change. Increasing the 
damping factor smoothens the set-point. 

3.1.3 Main Vars, Service State, Press and System Status area 

This window reports information about the positioner: 
- The LED in the top-right position informs the user about the communication status (YELLOW LED 

blinking: communication ok - RED LED: communication problem); 
- ActPos [%]: actual position measured by the positioner; 
- ReqPos [%]: input signal or request position. The source of the requested position depends on the 

‘service state’. If the system is put ‘in service’ mode, the requested position depends on the 4-
20mA input signal and the split range setting. If the system is put in ‘out of service’ mode, the 
requested position is equal to the setpoint setting by remote control; 

- ErrPos [%]: equal to the difference between ReqPos and ActPos;  
- Input [mA]: current read by the 4-20mA loop current input channel; 
- PI [bar]: line pressure; 
- P Out 1 [bar]: pressure measured at port 1 of the positioner; 
- P Out 2 [bar]: pressure measured at port 2 of the positioner; 
- System Status window: displays the status of the device (the same information is also available 

with CMD48 of the HART protocol). Following the error list ([latched] means that the error condition 
occurred before, but it is not present now; [instantaneous] means that the error condition is 
currently present): 
- "Error [latched] - user configuration has been reset"  
- "Error [latched] - user configuration data failed recovery"  
- "Error [latched] - factory settings have been reset"  
- "Error [latched] - factory settings were corrupt at power on" 
- "Error [latched] - system has not been configured (perhaps first power on?) 
- "Error [latched] - system is uncalibrated" 
- "Error [latched] - the pot has not been linearized"  
- "Error [instantaneous] - too close physical limits"  
- "Error [instantaneous] - position encoder out of range" 
- "Error [instantaneous] - DP sensor out of range"  
- "Error [instantaneous] - supply pressure sensor out of range"  
- "Error [instantaneous] – port A sensor out of range"  
- "Error [instantaneous] - supply pressure < min pressure" 
- "Error [instantaneous] - |error|=>5% for =>10seconds"  
- "Error [latched] - too close physical limits" ' 
- "Error [latched] - position encoder out of range" 
- "Error [latched] - DP sensor out of range" 
- "Error [latched] - supply pressure sensor out of range" 
- "Error [latched] – port A sensor out of range" 
- "Error [latched] - supply pressure < min pressure" 
- "Error [latched] - |error|=>5% for =>10seconds" 
- "Status - setpoint is being clamped (lower clamp)" 
- "Status - setpoint is being clamped (upper clamp)" 
- "Status - cut off is active" 
- "Status - cut off is active" 
- "Status - system not in service" 
- "Status - position <= limit 1"  
- "Status - position => limit 2" 
- "Communication Lost" 
- "Operation failed" 
- "System calibration completed" 
- "System calibration in progress" 
- "System calibration failed" 
- "Hard limits calibr.completed" 
- "Hard limits calibr.in progress" 
- "Hard limits calibr.failed" 
- "Loop curr.ADC 4mA calib.completed" 
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- "Loop curr.ADC 4mA calib.in progress" 
- "Loop curr.ADC 4mA calib.failed" 
- "Loop curr.ADC 20mA calib.completed" 
- "Loop curr.ADC 20mA calib.in progress" 
- "Loop curr.ADC 20mA calib.failed" 
- "Pos.ADC 0degrees calib.completed" 
- "Pos.ADC 0degrees calib.in progress" 
- "Pos.ADC 0degrees calib.failed" 
- "Pos.ADC 90degrees calib.completed" 
- "Pos.ADC 90degrees calib.in progress" 
- "Pos.ADC 90degrees calib.failed" 
- "PI Press.Sens.0bar calib.completed" 
- "PI Press.Sens.0bar calib.in progress" 
- "PI Press.Sens.0bar calib.failed" 
- "PI Press.Sens.3bar calib.completed" 
- "PI Press.Sens.3bar calib.in progress" 
- "PI Press.Sens.3bar calib.failed" 
- "Analog out DAC 4mA calib.completed" 
- "Analog out DAC 4mA calib.in progress" 
- "Analog out DAC 4mA failed" 
- "Analog out DAC 20mA calib.completed" 
- "Analog out DAC 20mA calib.in progress" 
- "Analog out DAC 20mA calib.failed" 
- "Store RAM to user flash completed" 
- "Store RAM to user flash in progress" 
- "Store RAM to user flash failed" 
- "Store RAM to factory flash completed" 
- "Store RAM to factory flash in progress" 
- "Store RAM to factory flash failed" 
- "Restore to factory settings completed" 
- "Restore to factory settings in progress" 
- "Restore to factory settings failed" 
- "Unknown state" 
- "Invalid AutoConfig Request" 
- "Limits Phase1: Encoder Out Of Range Before Stroke" 
- "Limits Phase1: UpStepTime Max Exceeded" 
- "Limits Phase1: DownStepWait Time Exceeded" 
- "Limits Phase1: DownStepTime Max Exceeded" 
- "Limits Phase1: Encoder Out Of Range During Stroke" 
- "Physical Limits: Min Diff Not Met" 
- "Time Phase1: StepWaitTime Exceeded UpStep" 
- "Time Phase1: Invalid RiseTime" 
- "Time Phase1: PostStepSettleTime Max Exceeded UpStep" 
- "Time Phase1: StepWaitTime Exceeded DownStep" 
- "Time Phase1: Invalid FallTime" 
- "Time Phase1: PostStepSettleTime Max Exceeded DownStep" 
- "Map Phase1: UpStrokeTime Max Exceeded" 
- "Map Phase1: DownStrokeTime Max Exceeded" 
- "Map Phase2: PreMoveWaitTime Exceeded" 
- "Map Phase2: MoveTime Max Exceeded" 
- "Map Phase2: SetpointErr Max Exceeded1" 
- "Map Phase2: SetpointErr Max Exceeded2" 
- "Map Phase3: PreMoveWaitTime Exceeded" 
- "Map Phase3: MoveTime Max Exceeded" 
- "Map Phase3: SetpointErr Max Exceeded1" 
- "Map Phase3: SetpointErr Max Exceeded2" 
- "Tune Phase1: PreStepSettleTime Max Exceeded" 
- "Tune Phase1: StartStepWaitTime Max Exceeded" 
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- "Tune Phase1: PreStepWaitTime Exceeded" 
- "Tune Phase1: PostStepSettleTime Max Exceeded" 
- "Tune Phase1: Oscillated Before Step" 
- "Tune Phase1: Num Setpoint Incs Max Exceeded" 
- "Tune Phase1: Position Move Too Small" 
- "Tune Phase1: Could Not Calculate PID Params" 
- "Digital Input Abort" 
- "User Abort" 
- "Feature Not Implemented" 
- "Calibration in progress (step " ... ")" 

- Clear latched errors (button): clears all the latched errors; 
- Diag (button): shows a window with all the communication errors that have occurred. When the 

button is displayed with a red LED on it, this means that at least an error has occurred. Press 
‘Clear’ button to erase the content of the Event Log window, ‘Exit’ button to close it: 
 
 

 
- Service State area allows to select the Service State: 

- In Service: Requested Position depends on the 4-20mA input signal; 
- Out Of Service (Manual): the Requested Position comes from the 'Setpoint' input box from 

remote control. When the Service State is set to ‘Out Of Service (Manual)’, the first manual 
setpoint is equal to the last ‘Actual position’ in order to have a bump less transition; 

- Out Of Service: special mode that gets automatically selected when the system is not 
calibrated. 

 

Warning 

 

Changing from ‘Out of Service’ to ‘In Service’ can cause the actuator to move. 
When the positioner is turned on it automatically starts in ‘In Service’ or ‘Out of Service’ 
according to the calibration status. 

 
  

Figure 6: 'Clear' and 'Exit' button 

Figure 7: Diag button 
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3.2 Remote Control – CFG page 

3.2.1 Position sensor 

The “Actual sensor pos. reading” (or “Pos. raw ADC reading”) reports the value read from the position 
sensor (bits). The same value is shown in the scroll bar below. During the mechanical linkage 
adjustment, the user can use this scroll bar to verify the linkage alignment: the value must fall inside 
the range. The best condition is when the 50% mechanical position is near the middle value of the 
scroll bar (2048 +/- 500) and when the 0% and 100% mechanical limit stay in blue/white area. 
 

Important 

 

In order to limit the travel of actuator, it is necessary to find the raw ADC value in 
correspondence of the hard limit and to manually set the raw ADC desired value. For 
example, suppose that for the lower hard limit the raw ADC reading is 1000 and for the 
upper hard limit the raw ADC reading is 3000. If the actuator travel must be reduced by 
5% on lower limit and 10% on upper limit, the raw ADC values to set are 1100 for lower 
limit and 2800 for upper limit. Then check the actual positions on end stroke and adjust if 
necessary. 

 
The “Position sensor adjustment button” opens a window to help the user move the actuator. The slide 
bar enables the user to select a safe speed to move in one direction or in the other. Move the slide to 
the desired position and press ‘Send’. To increase the movement speed, move the slider away from 
the mid position 
  

Figure 8: CFG Page 
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3.2.2 System Calibration 

Starts the calibration and the self-tuning procedure. The ‘Only stroke’ option allows the calibration of 
the hard limits without performing the full self-tuning procedure. 

 

3.2.3 4-20mA Calibration 

Important 

 

Make sure that the positioner is supplied with a stable, accurate 4mA and 20 mA reference. 

 
Start the calibration of the selected option: 

- Loop Current ADC 4mA: reads the actual value of the input current and calibrate the internal 
system to always read this value as 4mA; 

- Loop Current ADC 20mA: reads the actual value of the input current and calibrates the internal 
system to always read this value as 20mA. 

 
  

Warning 

 

When the ‘Send’ button is pressed the actuator will move. 

Warning 

 

When the ‘Start’ button is pressed the actuator will move. 

Figure 9: Position Sensor Adjustment 
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3.2.4 Warning limits Cfg 

Select ‘Configuration’ button to insert position limits and the minimum supply pressure. 
 

3.2.5 Split range input 

Lower range value and Upper range value are referred to the 4-20mA input. A minimum distance of 
20% is required between Lower and Upper value, so up to 5 split range area can be configured. The 
result of the split range is then evaluated by the ‘Transfer Function Curve’. 
(example 1: if the Low range value is equal to 0% and Upper range value is equal to 100%, thus the 
resulting Requested positions are 0% for 4mA and 100% for 20mA). 
(example 2: if the Low range value is equal to 0% and Upper range value is equal to 50%, thus the 
resulting Requested positions are 0% for 4mA and 100% for 12mA). 

3.2.6 Input char 

Specifies the relationship between the Input signal and the Requested Position. The ‘Transfer 
Function Curve’ shows the effect of Split Range Function in a graphical way. Selects one of the 
following functions: 

- Linear 
- Standard 1-50: equipercentage 1:50 
- Standard 50-1: inverse equal percentage 1:50 
- User: user defined 
- Standard 1-25: equipercentage 1:25 
- Standard 25-1: inverse equal percentage 1:25 
- Standard 1-30: equipercentage 1:30 
- Standard 30-1: inverse equal percentage 1:30 
- Feedback Linearization 
  

Figure 10: Warning limits configuration 
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Opens the Transfer Function Curve window using the ‘Transfer Function Curve’ button: 
- The ‘Close’ and ‘Open’ labels on the ‘Requested position’ axis show the effect of the ‘Signal 

Fail Action’ selection; 
- The ‘4.0mA’ and ’20.0mA’ on the ‘Signal Position’ axis show the effect of the ‘Split Range’ 

setup; 
- The effect of ‘Limit’ and ‘Cutoff’ are shown on the graph; 
- Only the ‘User Curve’ can be modified, the other curves are fixed. In order to generate a user 

curve starting from a standard curve proceed as follows: 
- Select the starting curve 
- Save the Table (File → Save Table). 
- Select ‘User Curve’ 
- Load the saved Table 
- Modify the table 

- To ‘Send’ a ‘User Curve’ to the Positioner press the ‘Send’ button; 
- The Signal Position steps are fixed, only the Requested position values can be changed; 
- A value can be changed either in the table or by clicking & dragging the corresponding dot in 

the graph; 
- If the shift key is held down when clicking on two dots, the system will automatically perform 

a linear interpolation between these two points. 
 

3.2.7 Analog Output 

Selects whether the Analog Output (4-20mA signal out) reports the ‘Actuator position’ or the ‘Reverse 
Actuator Position’. 
  

Figure 11: Example of the Linear Transfer Function Curve 
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3.3 Remote Control – HART page 

 

3.3.1 HART PARAMETERS 

- Tag: Tag is an 8-character label assigned by the user that is based on the location and the use of 
the field device. It is coded as an 8-character Packed ASCII string (6 bytes) and it is used to identify 
the field device. The term originated when physical tags were attached to instruments for this 
purpose; 

- Date: Date is coded by means of three 8-bit binary unsigned integers that represent, respectively, 
the current day, month and year (minus 1900). It is used by the Master for record keeping (e.g. 
last or next calibration date); 

- Descriptor: Descriptor is a 16-character Packed ASCII string (12 bytes) that is used by the Master 
for record keeping. The default value is a blank string; 

- Message: Message is a 32-character Packed ASCII string (24 bytes) used by the Master for record 
keeping. The default value is a blank string; 

- Polling address: in the HART Protocol, the polling address is an integer used to identify the field 
device. It is used to construct the Short Frame Address. The Polling Address is set to 0 in point-
to-point installations; 

- Dev. ID: this number is different for every device manufactured with a given Manufacturer ID and 
Device Type. It corresponds to the serial number (see page 7). 

 

3.3.2 HART Protocol 

Shows some communication parameters which may be useful for debugging communication problem. 
 

3.3.3 HART Communication 

‘Time management’ and ‘Time management (performance)’ are two different ways to manage the Hart 
modem. In case of communication problems, a possible solution is to change this option. 
 

  

Figure 12: CFG Page 
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3.4 Remote Control – Advanced page (only for advanced users) 

 

3.4.1 Cutoff pressures (bar) 

It is the pressure used at the fully close (open) position when the Cutoff is enabled. The default value 
is 10bar. In order to speed up the movement of the valve during the opening (closing) phase and from 
the fully close (open) position, it may be useful to reduce the pressure set. 
 

Warning 

 

If the cutoff pressures is too low, the valve could be not fully closed, thus leakage occurs. 
In some applications, the valve can be damaged. 

 

Warning 

 

The pressure limitation is valid only when the positioner is on. When the power supply (4-
20mA loop) is removed, the output pressure from the positioner is equal to the line 
pressure, so actuator and valve must be able to withstand the full pressure. 

3.4.2 Analog output DAC calibration 

The analog output (4-20mA passive loop) is calibrated during the production phase but any adjustment 
can be done in this window. In order to ‘reverse' the output, a specific function is provided in the ‘CFG’ 
window (see ‘Analog Feedback’): the analog output calibration must not be used for this purpose. 

3.4.2.1 4mA calibration 

Move the actuator in the 4mA position, then check that CUTOFF is active in this position in order 
to have a ‘stable’ signal. 
If the measured output is different from 4mA, change the value of the DAC calibration (‘32’ in the 
picture). 

 

Figure 13: CFG Page 



 
 

_____________________________________________________________________________________ 
STI S.r.l. – Via Dei Caravaggi 15, 24040 Levate (BG) – ITALY        www.imi-critical.com 

   

Manual 4050, rev. 01 04/2019 – FTC Software  - 16 - 

Increase the value if the measured 
output is less than 4mA or decrease the 
value if it is greater. When finished press 
the ‘Start Calibration 4mA’ button. 

3.4.2.2 20mA calibration 

Move the actuator in the 20mA position, 
check that CUTOFF is active in this 
position in order to have a ‘stable’ signal. 
If the measured output is different from 
20mA, change the value of the DAC 
calibration (‘576’ in the picture). 
Increase the value is the measured output is less than 20mA or decrease the value if it is greater. 
When finished press the ‘Start Calibration 20mA’ button. 

3.4.3 0-100% position (4mA action invertion) 

The ‘0-100% Position’ panel is useful to set the relationship between the 4mA value and the valve 
status (‘Close’ or ‘Open’). 

 
By design, when the power is removed (4-
20mA signal), the FasTrak Compact 
positioner has: 
- Port ‘A’ connected to the 
atmosphere 
- Port ‘B’ fully pressurized 

 
 
So the position of the valve when the 
power is removed depends on the 
pneumatic connection. 
(an exception to the above rule is when the 
‘Fail Freeze’ option device is used, in this 
case – by means of a special electronic 
device and 3-way valves – the position 

when the power is removed is the last valid one). 
By default the ‘4mA position’ is the same as the power fail position. 
During the ‘SelfTune’ procedure it has to be specified if the valve is ‘close’ or ‘open’ when the power 
is removed. This is to make a relationship between the parameter used for the tuning and the effect 
on the valve, it is not a way to adjust the movement direction because it depends on the pneumatic 
connection. 
The ‘Fail Position’ field shows what was selected during the 'Selftune' procedure. If necessary it can 
be changed. 
The ‘4mA Position’ field allows to change the ‘4mA position’ vs ‘Fail Position’. 
 
 

Figure 14: Calibration 

Figure 15: 4mA Position 
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Warning 

 

Setting ‘4mA Position’ different from ‘Fail position’ can be dangerous: if for example with 
4mA the valve is fully open, when the input signal goes below the minimum threshold then 
the valve moves to the fully close position. If the input signal is unstable and close to the 
minimum value, it may happen that the valve continuously moves between the close and 
the open positions. 

 
  

Figure 16: Fail Position 
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3.5 The Graph window 

This feature allows user to record set point and position signal waveforms for 10 seconds. Moreover, it comes 
with some tools to analyse the acquired waveforms. This feature is only available on the “RCFTC” program 
with an RS232 connection. 

Using the up/down and right/left arrows on the keyboard it is possible to move in the graph’s window. 
It is also possible to “zoom in”: hold the left mouse button, define the area to zoom in, then release the left 
mouse button.  

 
File-> Save Image: The graph is saved as a bitmap picture 
File-> Save Graph: The graph is saved as a ‘collection of data’. It can be useful in order to reload it 

again. 
File-> Load Graph: Loads a graph that was previously saved with ‘Save Graph’. 
File-> Graph Compare:  Loads another graph to compare it with the present one. In order to ‘align’ the two 

graphs, keep the ‘SHIFT’ key and the mouse ‘right button’ pressed, then move in 
the graph area (to the left or to the right). 

Figure 17: Graph Window 

Figure 18: Graph Window Menu 
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3.5.1 The Menu 

Menu : File 

o Load: 
Loads into RCFTC a previously saved set of parameters.  

o Save: 
Saves the current set of parameters in a .qtp file. 

o Report: 
Creates a document in .rtf format with the actual parameters (like the Save command but 
the file format is compatible with text editing software). 

o Exit: 
Closes the application. 

Menu : Device 

o Download: 
Performs the same function as the quick button.  

o Upload Param 
Sends the displayed parameters to the positioner. 

o Upload Param + Calib data 
Same as the Upload Param command but it additionally sends calibration information 

Menu : Password 

o Login 
Performs the same function as the quick button  

o Change  
Changes the password 
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3.6 System Calibration: Self Tune 

The ‘self-tune’ wizard can be started by pressing the ‘Start System Calibration’ button. 
More information about this procedure can be found in the specific ‘Installation Instruction Manual’. 
 

3.6.1 Starting page 

 
You must specify what happens when the 4-20mA signal is removed (with the air present). Based on the 
pneumatic connection the actuator moves in one direction or in the other (when the 4-20mA signal is 
removed, portB is fully pressurized). 
 

Warning 

This panel is to inform the positioner about the action and not to specify the user-desired 
behaviour (as the positioner cannot change the mechanical default piston). 
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3.6.2 Position sensor alignment 

The following page helps you to align the position sensor. 

 
 
The ‘Position sensor adjustment’ button opens a window with a tool to move the valve.   
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3.6.3 Actuator volume 

Specify the size of the actuator: 

 
Select the type of the actuator: 
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3.6.4 Booster type 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3.6.5 ‘Only stroke’ or ‘Fully calibration’ 

 
Select ‘Control parameters 
and stroke’ to perform a full 
SelfTune procedure. 
 
If ‘Fast Calibration’ is 
checked, a faster SelfTune 
procedure starts. 
 
Select ‘Only stroke’ to just 
update the hard limits of the 
valve. 
 
Press ‘Start’ to perform the 
SelfTune  
 
The progress bar informs 
you about the ‘SelfTune’ 
status. 
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3.7 Option pack 1 : Diagnostic for Critical Severe Service Valves  

This option pack add important diagnostic features. 
To activate option 1 a specific key must be typed on main menu Password➔Key 
 

3.7.1 Valve Signature 

 
The ValveSignature option allows to check the status of the 
valve. 
 
 
The valve is moved in a configurable stroke range, data are 
collected and the report shows the delta pressure (trust) vs 
position. 
 
 
 
 

Warning 
The ValveSignature procedure moves the valve regardless the 4-20mA setpoint. 
This action can be dangerous for people or for the process. 
Before starting the ValveSignature procedure double-check that all the safety 
requirements are met. 

 
In order to start the ValveSignature procedure press the button in the main page: 

The ValveSignature configuration window appears: 

 
 

- Input Start: 

Figure 19: Valve signature 
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Specifies the starting point for the test. 
- Input End: 

Specifies the final point for the test. 
- Velocity Limit: 

Specifies the stroke speed that must be used for the test. Usually for a good investigation a long time 
is required. 
 

In order to start the test, the FasTrak Compact must be in ‘Manual’ mode. If it is in ‘In Service’ mode the SW 

can, with the user consent, automatically change the status to 'Manual'. 
 
As the ValveSignature procedure is running it is possible to see what is going on (actual position, DeltaP). 
 
In this phase the Graph shows data (i.e. position & DeltaP) versus time. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

 

Opens a saved ‘ValveSignature’ test 

 

Saves the actual ‘ValveSignature’ results 

 

Creates a report with the results 

 

Shows in a graphical way the collected data 
(as well as the test is running) 

 
 
 
 

STARTS the ValveSignature procedure 

 

STOPS a running ValveSignature procedure 

 

Shows the details about the 
‘ValveSignature’ process status 

 

Exits 

Figure 20: Time View Figure 
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When the ValveSignature procedure is completed the Graph shows DeltaP versus position. 
 
 
 
 
It is possible to switch from one visualization 
to another by means of the buttons ‘Time 
view’ and ‘VS view’. 
 
 
 
 
In addition, it is possible to load another 
ValveSignature graph to make a comparison 
with the current one. 
 
 
 
 
 
 
The button ‘Err view’ shows the dynamic error vs position: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Figure 21: VS View Figure 

Figure 22: Err View Figure 
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3.7.2 Step Response 

The Step Response option allows to move the valve to different positions based on a list of endpoints. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Warning 
The Step Response moves the valve regardless the 4-20mA setpoint. 
This action can be dangerous for peoples or for the process. 
Before starting the Step Response procedure double-check that all the safety 
requirements are met. 

 
In order to start the Step Response procedure, press the button on the main page: 

The Step Response configuration window appears: 

Pressing the ‘Step Response Wizard’ button the ‘Automatic Step Generation’ window appears: 
 

Figure 24: 
Step Response 

Wizard 

Figure 23: Step Response Test 
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- Start Point:  
First Position for the test. 
 

- Number of Steps: 
Number of points in the table 
 

- End Point: 
Final position for the test. 
 

- Step Ramp Time [sec]: 
Stroke time applied to each step. 
 

- Collection Time [sec]: 
Delay after the execution of each 
step. 
 

- Up and Down flag: 
When this option is selected, the table has 2 x ‘Number of Steps’ and the table has steps both in the 
UP direction and in the DOWN direction. 

 
The ‘Generate’ button creates the table. 

 
 
 
It is possible to change the values in 
the table. 
 
It is also possible to remove or add a 
new line in the table (with the mouse 
pointer on the table, press the right 
button and a specific menu appears). 
 
 
 
 
 
 
 
 

 
In order to start the test, the FasTrak Compact must be in ‘Manual’ mode. If it is in ‘In Service’ mode the 
SW can, with the user consent, automatically change the status to 'Manual' 
 
Press the ‘Start’ button to initiate the test. 

 
As the Step Response procedure is running it is possible to see what is going on in the Graph Window. 
  

Figure 25: Start 
Button 
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At the end of the test it is possible to see the details of the test with information about the dead time, the T63 
and T86 of the specific step, the overshoot (with the percentage of the overshoot related to each step). 

 
Pressing the ‘Create Report’ button a detailed test report is generated. 

 
Disclaimer: 
The automatic output data analysis can be affected by imprecision generated from different causes, e.g. 
noise affecting the input signal, multiple overshoot, ... 
Any data can be verified on graph record. 
 
  

Figure 26: 
Create Report 

Button 
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4 Display: self-tuning guide 

Warning 

The actuator will move during the self-tuning. 

 

Follow these steps using the display buttons (ENT, DOWN, UP, ESC): 

- turn on the FTC smart positioner; 

- push any button and then enter the password (ENT-UP-DOWN-UP-DOWN); 

- select set-up from main menu; 

- select operating mode menu from set-up menu; 

- select “Out svc” in the operating mode menu; 

- come back to set-up menu; 

- select actuator menu from set-up menu; 

- chose the actuator type; 

- come back to main menu; 

- select calibration menu from main menu; 

- select full self-tuning menu from calibration menu; 

- start the self-tuning. 

See Fig.7 for more details. 

  

It is also possible to have the benefit of high-speed connection on the electronic board (restricted to 

use in a non-hazardous area) following the indications below: 

- remove the cover by removing the #4 M5 screws; 

- only the STI “FTx positioner connection cable” can be used to connect the FTC to the laptop; 

- the laptop used must be powered from battery or by a power supply unit in compliance with IEC 

60950-1, with Maximum Output Voltage (Um) ≤ 30V; 

- see Instruction Manual 4050 for more details about the FTC remote control; 

- when the High-speed connection is not required, remove the “FTx positioner connection cable” 

and mount the FTC cover by #4 M5 screws (tightening torque = 4Nm). 

For Intrinsically Safe design details (FTC-I), see related Safety Manual 9031. 

 
Figure 27: FTC cover 
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MAIN PAGE PASSWORD ENTER PASSWORD 
ENT-UP-DOWN-UP-DOWN 

MAIN MENU 
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5 375 HandHeld & DD files 

5.1 INSTALLATION  

375 Easy Upgrade Programming Utility is required to upload/download files to/from the 375 Field 
Communicator. 
- Start the Programming Utility. 
- Verify that the 375 is up-to-date, checking and updating the HART Application for 375 if it is necessary.  
 
Refer to the 375 Field Communicator User’s Manual for reference. 

 
- Select File/Import DDs from Local Source 
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- In the Select Path to DD Files dialog, browse to the location of the DDP (directory \375 on the FTC 
installation CD). 

- Each DDP (Device Driver Package) consists of two files. A DD binary has an .hdd file extension, 
and a corresponding binary header has an .hhd file extension. 

- Select OK after the desired DDP(s) have been found. The Programming Utility adds the selected 
DDP(s) into its database. 

5.2 CONNECTION  

- Connect the FTC device to the 375 (refer to the 375 Field Communicator User’s Manual if you 
need instructions). 

- Turn on the 375 Field Communicator. The 375 Main Menu is displayed with HART as the default 
application. 

- Double HART application to run the HART application. 
 

On startup, the HART application will automatically poll for devices. 
If a live HART device is connected to the 375 Field Communicator, the HART Application main menu will 
be displayed automatically with key parameters from the connected device. 

5.3 MENU 

(*) → Method (i.e. wizard) 
(**) → Graphical element (e.g. gauge, graph, chart, etc.) 
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6 AMS SW Interface  

AMS Software is the configuration, calibration, and diagnostic tool. It allows maintenance and operations 
personnel to monitor control valve health and performance on-line and improve reliability by spotting 
problems before they affect the process. 
 

6.1 INSTALLATION 

Close AMS if it is running. Disconnect any devices from the system running AMS. 
- Select START > Programs > AMS > Add Device Type Manually to open the device installation 

program. 
- Follow the directions on the screen to install the device. 
- Once the installation is complete, you’re ready to connect your device. 

6.2 CONNECTION 

- Once your device has been connected (refer to AMS 
Installation Guide for information on how to connect a 
device to AMS) start AMS (refer to the AMS User’s 
Guide if you need instructions). 

- Open the Device Connection view, if it is not already 
open (View > Device Connection View). 

 
After a short delay, you should see the FTC device attached to the modem. 

6.3 DEVICE CONTEXT MENU 

The device context menu appears when you click the right mouse button on the device in either the 
AMS Device Connection View or the AMS Explorer. 
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6.4 PROCESS VARIABLES 

Selecting Monitoring… from the device’s context menu displays the device’s Process Variables screen, i.e., 
the faceplate. The faceplate reports summary information for the FTC device (primary variables, system 
status, errors…). 

 
 
You can also double-click the FTC device icon from the Device Connection view to open the FTC faceplate 
and display the process variables. 
 

Figure 28: AMS Main Page 
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6.5 CONFIGURE/SETUP 

Selecting Configure/Setup from the device’s context menu, displays the Configuration Properties screen. 

6.5.1 System Setup 1 & 2 

These windows show the tuning parameters that are part of ‘Tuning’ & standard ‘System setup’ area 
of the standard RemoteControl interface (refer to the FT IOM for explanation of the parameters). 
 
In order to change parameters, the FTC must not be in ‘In service’ mode. 

6.5.1.1 Operation mode 

 

6.5.1.2 Travel Control 
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6.5.1.3 Tuning 

6.5.1.4 Cutoff Pressures 

6.5.1.5 0 - 100% Position 
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6.5.1.6 Reset Setting 

 

6.5.1.7 Analog Output  
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6.5.1.8 Position Sensor 

6.5.1.9 Split Range Input 
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6.5.1.10 Manual Mode 

6.5.1.11 Input Char. 

 
  



 
 

_____________________________________________________________________________________ 
STI S.r.l. – Via Dei Caravaggi 15, 24040 Levate (BG) – ITALY        www.imi-critical.com 

   

Manual 4050, rev. 01 04/2019 – FTC Software  - 43 - 

6.6 EDIT A CONFIGURATION PARAMETER  

In order to change the setting of the FTC positioner is possible to change the value of one of the fields shown 
in the window. 

 
 
To send the new value to the positioner click on the ‘Send’ button. 
 
A confirmation window appears, click on Yes to apply the changes. 
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6.7 START THE CALIBRATION  

In Configure/Setup click on Calibration to access the Calibration menus and wizards. 

6.7.1 Calibration 

6.7.2 Device Calibration 
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6.7.3 DP Calibration Data 

 

6.8 ADVANCED TESTS  

In Configure/Setup click on Advanced Tests to access the advanced tests wizards. 

6.8.1 Step Response 
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6.8.2 Valve Signature 
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6.9 HART COMMUNICATION  

In Configure/Setup click on HART Communication to view information regarding HART protocol. 

 

6.10 DIAGNOSTICS 

In Configure/Setup click on Diagnostics to access the Diagnostics menus and wizards. 

6.10.1 Device Status 
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6.10.2 System Status 
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6.10.3 Latched Errors 

 

6.10.4 Instant Errors 
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6.10.5 Diagnostics 

 

6.11 DEVICE INFO  

In Configure/Setup click on Device Info to view information about FTC. 
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7 Error/Diagnostic Bits in HART protocol 

With HART protocol is possible to get different information about error and diagnostic. The HART protocol 
uses different ways to provide this information. 
 

7.1 Device Status 

This byte is part of any answer. 
Bit [0] = Primary variable Out of limits    Not implemented 
Bit [1] = Non Primary variable Out of limits   Not implemented 
Bit [2] = Loop Current saturated     Not implemented 
Bit [3] = Loop Current Fixed 
Bit [4] = More status available     Implemented starting from rel. 1.4.2 
Bit [5] = Cold Start    
Bit [6] = Configuration changed 
Bit [7] = Device Malfunction 
 

7.2 Common practice command CMD48: Read additional device status 

It is a special command that provide and ‘extended status’ 
[0] = Response command 
[1] =Device status 
[2] =Extended status byte0 
[3] =Extended status byte1 
[4] =Extended status byte2 
[5] =Extended status byte3 (bits 8...15) 
[6] =Extended status byte3 (bits 0...7) 
…. 
 

7.3 Extended status byte 0: 

[0]    "Configuration reset”,       Error [latched] - user configuration has been reset 
[1]    "Conf.failed recovery”,       "Error [latched] - user configuration data failed recovery"}, // (bad) 
[2]    "Fact.settings reset",         "Error [latched] - factory settings have been reset"}, // (bad) 
[3]    "Fact.sett.corrupted",         "Error [latched] - factory settings were corrupt at power on"}, // (bad) 
[4]   "Watchog timeout",             "Error [latched] - a watchog timeout caused the last system reset"}, // (bad) 
[5]    "Syst.not configured",         "Error [latched] - system has not been configured (perhaps first power 
on?)"}, //  
[6]    "System uncalibrated",         "Error [latched] - system is uncalibrated"}, // (bad) 
[7]    "Pot not linearised",          "Error [latched] - the pot has not been linearised"} // [latched] 
 Bits 0,1,2,3,4,5,6 change the ‘More status available’ bit 
 

7.4 Extended status byte 2: 

  [0] "Too close phys.limits",       "Error [latched] - too close physical limits"}, 
  [1]    "Pos.enc.out of range",        "Error [latched] - position encoder out of range"}, 
  [2]    "DP sens.out of range",        "Error [latched] - DP sensor out of range"}, 
  [3]   "PI sens.out of range",        "Error [latched] - supply pres sensor out of range"}, 
  [4]    "PA sens.out of range",        "Error [latched] - portA sensor out of range"}, 
  [5]    "PI press.< min press.",       "Error [latched] - supply pressure < min pressure" }, 
  [6]    "(Err)=>5% for =>10s",         "Error [latched] - (error)=>5% for =>10seconds"}  
 

7.5 Extended status byte 3: 

[0]    "Setpoint clamped-low",  "Status - setpoint is being clamped (lower clamp)"}, 
   [1]    "Setpoint clamped-upp",  "Status - setpoint is being clamped (upper clamp)"}, 
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   [2]    "Cut off is active 1",   "Status - cut off is active"}, 
   [3]    "Cut off is active 2",   "Status - cut off is active"}, 
   [4]    "DP clamp is active",    "Status - the DP clamp is active"}, 
   [5]    "System not in service", "Status - system not in service"}, 
   [6]    "Position <= limit 1",   "Status - position <= limit 1"}, 
   [7]    "Position => limit 2",   "Status - position => limit 2"}, 
   [8]    "Digital In 1 is on",    "Status - Digital In 1 is on"}, 
   [9]    "Digital In 2 is on",    "Status - Digital In 2 is on"},   
   [10]    "Digital Out 1 is on",   "Status - Digital Out 1 is on"},   
   [11]    "Digital Out 2 is on",   "Status - Digital Out 2 is on"},   
   [12]    "Syst.override actived", "Status - digital input has activated system override"} 
Bits 10 and 11 change the ‘More status available’ bit 
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8 Self-tune phases 

110 Finding valve limits... 
     
     

 

The system is in fixed DP mode in the 'up' direction, and is waiting for 
the actuator to start moving. 

120 The system has begun moving in the up direction in fixed DP mode, 
and is waiting for the actuator to stop moving. 

130 The system has stopped moving in the up direction, and is now applying 
full +DP for a set 'dwell time' at the end stop. 

140 The system is in fixed DP mode in the down direction, and self tune is 
waiting for the position to start moving. 

150 The actuator has started moving in the down direction, in fixed DP 
mode. 

160 The actuator has stopped moving, and is assumed to be at the end 
stop. 
Self tune is waiting for a pre-set dwell time, with full -DP. 

170 Finished finding 
actuator limits. 
 

The result of the mechanical limits search is being processed and 
assigned to storage variables. 
This is really just a dummy state which is exited after one cycle. 

176 Calibrating the 
system... 
 

The system is in open loop fixed DP mode, moving up, and self tune is 
waiting for the position to cross a high threshold. 

178 The system is in open loop fixed DP mode, and is approaching the end 
stop, waiting for the position to stop moving. 

180 The system has applied a PWM setting to the output port and is waiting 
for the DP to either come close to a threshold (first loop) or cross a 
threshold (subsequent loops). 

182 The system has applied a fixed DP value and is waiting for the actuator 
to cross a low threshold. 

184 The actuator has crossed the required low threshold, and the system is 
now waiting for the actuator to stop moving 

186 The system has applied a PWM value and is waiting a fixed period of 
time for the pressure to settle before continuing. 
The length of time of between each change is different depending on 
whether this is the first change. 

210 Measuring the stroke 
time... 
 

The system has applied a +10bar DP, and is waiting for the actuator   
to cross a high position threshold 

220 The system is calculating the rise time and waiting for the actuator to 
stop moving at the high end stop.  

230 The system has applied a -10bar DP and is waiting for the actuator to 
cross a low position threshold. 

240 Finished measuring 
stroke time. 

The system is calculating the fall time and waiting for the actuator to 
stop moving at the low end stop. 

310 Characterizing 
actuator... 
 

The temporary friction/DP offset maps have been cleared, and the 
system has been put into closed loop velocity mode, with a slow upward 
velocity.  The system will slow down (i.e. reduce the target velocity) just 
before each 10% marker and measure the DP at each point. Self tune 
continues like this until the position crosses 95%. 

320 The same procedure as in the previous step, except the target velocity 
is in the down direction.  Self tune continues until the actuator reaches 
5%. 

330 Measuring friction... 
 

To check the previous friction reading, self tune is measuring the friction 
at the valve midpoint. P only control is used, and the target position is 
set to 50%. Waiting for the actuator to start moving. 

340 The actuator has started moving, self tune is now waiting for it to settle 
at a point. 

350 The actuator has stopped moving, self tune is now waiting for a pre-set 
time before incrementing/decrementing the setpoint towards the target. 
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After each change of the setpoint, self tune watches to see when the 
position crosses the target (50%). 

360 The threshold has been crossed in one direction. Self tune is now 
adjusting the setpoint in the other direction 

370 Finished 
characterizing 
actuator. 

The measurements have finished, and calculations are being 
performed on the results. 
This is a state which should be immediately exited. 

375 Detailed 
characterization... 
 

This state is only used during transition.  It is the start of the DP/friction 
mapping phase 3, using break-away pressures at 10% intervals along 
the stroke. 

380 Detailed 
characterization.... 
 

The system is trying to move the actuator to a start position and is 
waiting for the actuator to start moving. 

385 The system is trying to move the actuator to a start position and is 
waiting for the actuator to stop moving. 

390 The system is gradually changing the setpoint and waiting for the 
actuator to cross a threshold 

395 The actuator has now crossed a threshold, and the system is waiting 
for the actuator to cross another threshold a short distance away. 
It continues increasing the setpoint to achieve this. 

396 The first crossing has been done, and the system is going back to 
measure the crossing in the other direction, or it has done both 
directions, and is now calculating the results. 
When the very last crossing has been done in both directions, this state 
is also the place where the full DP offset map is calculated. 

410  Tuning test... 
 

The system has set up the PID with default tuning parameters, put the 
system into closed loop control mode, and is now waiting for the  
actuator to stop moving at a target start point. 

415 The actuator has now slowed down, and the system is waiting for the 
actuator to stop moving completely. 

420 The system is now making micro adjustments to the setpoint to get the 
actuator into a known start position for a step test. 

425 The system has now been put into fixed DP mode, and a drive DP has 
been applied. The reaction rate of the system will be used to tune the 
PID.  In this state, we are waiting for the actuator to move 

430 The system is now waiting for the actuator to cross 60%. 

440 Tuning test complete. 
 

The system is now calculating the PID tuning parameters besed on the 
ZeiglerNichols reaction rate method. 

1000 Self tune complete! The self tune completed successfully with no errors 
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9 Error codes 

111   Position sensor out of range. 
 

The position sensor is not within its measurable range.  
Please check   the alignment of the position sensor to the 
actuator travel. 
Other possible reasons: 

• The position encoder is electrically disconnected. 

• The position encoder is faulty. 

121  Movement took too long. 
 

The actuator did not move quickly enough in the positive 
direction 
Possible reasons: 

• The actuator is too big for the positioner to control 
directly. 

• When trying to find the actuator limits, the actuator 
exceeded  the maximum allowed up-step time.  This 
usually happens when the actuator doesn't move at 
all. 

131 Movement timed out The actuator did not move away from it's positive end stop. 
Possible reasons: 

• The position sensor is mechanically disconnected. 

• The position sensor is electrically disconnected. 

• The air supply failed during the test. 

• A fault occurred with the positioner. 

• While trying to find the actuator limits, the actuator 
reached. 

• the upper end stop, but then didn't move away from 
the upper end stop. 

141  Movement took too long. 
 

The actuator did not move quickly enough in the negative 
direction 
Possible reasons: 

• The air supply failed during the test. 

• An external force is causing abnormal movement of 
the actuator. 

151  Position sensor out of range! 
 

The position sensor went out of range during the self tuning. 
 Possible reasons: 

• The position sensor is not correctly aligned for the 
actuator and linkage. The sensor must be within its 
active range for the full stroke of the actuator, and 
this means the start point must be set to allow the 
full travel to be sensed.  Please turn off the air supply 
and adjust the potentiometer rotation. 

• The position sensor became electrically 
disconnected during the  

• test.  Please check the electrical connections before 
continuing. 

152 Position sensor stroke range too 
small! 
 

The position stroke range was too small.  For correct 
functioning of the positioner, the system requires good 
resolution on the position sensor, which requires a minimum 
difference between the min and max travel points, of at least 
15 degrees.  Please adjust or change the linkage to give 
more rotation of the sensor and aim for use 90 degrees or 
more for best results. 

174 The pneumatic system is 
unstable on this actuator. 
 

With the factory configuration, the pneumatic system can 
oscillate on small actuators, or setups with narrow bore 
pipes. To solve this problem, turn the PCB trimmer labeled 
'SEN.', one turn clockwise. This reduces the sensitivity of the 
pneumatic system.  
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Turn an additional revolution if the problem persists. 
You can reset to factory settings by turning the 'SEN.' 
trimmer multiple turns anticlockwise, the total range is 11 full 
revolutions, and there is no hard stop at the end of the range.  
Never adjust the potentiometer marked 'SPL NULL'. 
This problem can also occur if there if there is a power supply 
fault, e.g. voltage supply instead of current supply. 
If we get here, the DP oscillation detection was triggered 
during the self tune. We need to give the user practical 
advice on what to do. 

176 Actuator movement took too 
long. 
 

The actuator did not move quickly enough in the positive 
direction or stopped before it had reached its end stop. 
Possible reasons: 

• The actuator air supply failed during the test. 

• The actuator is single acting, and but the 
single/double acting selector plate on the circuit 
board is in double acting mode. 

178   Actuator did not stop at end 
stop. 
 

The actuator came close to reaching the travel limit but did 
not stop.  
Possible reasons: 

• There is too much noise in the system. 

• The air supply is unstable. 

• An external force is moving the actuator. 

180   Internal calibration failed. 
 

The self calibration of the system failed.  Please contact your 
customer support contact to arrange for the unit to be 
returned. 
If we get to here, then it means that the pilot has either drifted 
too far out of calibration, or it is broken/intermittent. In both 
cases, we want the unit back in the lab to investigate. 

182 Actuator movement took too 
long. 
 

The actuator did not move quickly enough in the negative 
direction or stopped before it had reached its end stop. 
Possible reasons: 

• The actuator air supply failed during the test. 

184 Actuator did not stop at end 
stop. 
 

The actuator came close to reaching the travel limit but did 
not stop.  
Possible reasons: 

• There is too much noise in the system. 

• The air supply is unstable." 

• An external force is moving the actuator. 

186 Internal calibration failed. 
 

The self calibration of the system failed.  Please contact your 
customer support contact to arrange for the unit to be 
returned. 
If we get to here, then it means that the pilot has either drifted 
too far out of calibration, or it is broken/intermittent. In both 
cases, we want the unit back in the lab to investigate. 

206 Actuator took too long or did not 
move. 
 

The actuator did not return to 0% within in the required time. 
Possible reasons: 

• The actuator volume is too large for the system to 
control "directly." 

• The position sensor linkage is faulty or has become 
disconnected. 

• There is a fault with the position sensor. 
The state here is just to allow the actuator to move back to 
the start of its travel, if the previous self tune step left the 
actuator in a strange place. We wait the full stroke time 
allowance, before timing out. 
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211 Actuator took too long or did not 
move. 
 

The actuator did not reach the required threshold in the 
required time. 
Possible reasons: 

• The actuator is single acting, but the system is 
configured as "double acting." 

• The actuator volume is too large for the system to 
control "directly." 

221 Error calculating rise-time 
 

An error occurred while calculating the rise time of the 
actuator.   
Please retry. If this error repeats, please contact your 
technical support representative. 

222 Actuator did not settle. 
 

The actuator did not stop moving after an up step. 
Possible reasons: 

• There is a fault with the position sensor. 

• An external force is moving the actuator. 

231 Actuator took too long or did not 
move. 
 

The actuator did not reach the required threshold in the 
required time 
Possible reasons: 

• The actuator is single acting, but the system is 
configured as double acting. 

• The actuator volume is too large for the system to 
control directly 

241 Error calculating fall-time 
 

An error occurred while calculating the fall time of the 
actuator.   
Please retry. If this error repeats, please contact your 
technical support representative. 

242 Actuator did not settle. 
 

The actuator did not stop moving after a down step. 
Possible reasons: 

• There is a fault with the position sensor. 

• An external force is moving the actuator. 

311 Actuator movement took too 
long. 
 

The actuator took too long to move when doing a controlled 
sweep of the actuator travel in the positive direction.  
Possible reasons: 

• The position sensor linkage is faulty or has become 
disconnected. 

• There is a fault with the position sensor. 

• An external force is moving the actuator. 

312 Unstable movement during self 
tune. 
 

The actuator did not move correctly with automatically 
assigned parameters  
Possible reasons: 

• Supply pressure is inconsistent during the test" 

• This type of actuator is not supported by the self 
tune, please record details of the actuator type, 
supply pressure and pneumatic configuration, this 
error code, and contact your technical support 
representative. 

321 Actuator movement took too 
long. 
 

The actuator took too long to move when doing a controlled 
sweep of the actuator travel in the negative direction.  
Possible reasons: 

• The position sensor linkage is faulty or has become 
disconnected. 

• There is a fault with the position sensor. 

• An external force is moving the actuator. 

331  Actuator failed to move. 
 

The actuator failed to move during a critical point of the self 
tuning. 
Possible reasons: 
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• The position sensor linkage is faulty or has become 
disconnected. 

• There is a fault with the position sensor. 

341 The actuator did not settle 
correctly. 
 

The actuator did not settle at when trying to move to a fixed 
point. 
 Possible reasons: 

• The actuator is too small for the system to control." 

• The inner loop gain is too high.  Contact your 
technical support representative. 

351 Could not move actuator. 
 

The actuator could not be moved while trying to measure the 
actuator friction. 
Possible reasons: 

• The position sensor linkage is faulty or has become 
disconnected. 

• The friction of the actuator is too great for automatic 
tuning. 

• An external force is jamming the actuator. 

• The air supply failed during the test. 

361  Could not move actuator. 
 

The actuator could not be moved while trying to measure the 
actuator friction. 
Possible reasons: 

• The position sensor linkage is faulty or has become 
disconnected. 

• The friction of the actuator is too great for automatic 
tuning. 

• An external force is jamming the actuator. 

• The air supply failed during the test. 

381 Actuator did not move 
 

The actuator did not move correctly to the start of a 
characterization test.   
Possible reasons: 

• The position sensor linkage is faulty or has become 
disconnected. 

• The air supply failed during the test. 

386 Actuator did not settle. 
 

The actuator did not settle while moving to the start of a 
characterization test. 
Possible reasons: 

• The actuator is too small for the system to control. 

• The air supply is unstable. 

391 Could not move actuator. 
 

The actuator could not be moved while trying to measure the 
actuator friction. 
Possible reasons: 

• The position sensor linkage is faulty or has become 
disconnected. 

• The friction of the actuator is too great for automatic 
tuning. 

• An external force is jamming the actuator. 

• The air supply failed during the test. 

396 Could not move actuator. 
 

The actuator could not be moved while trying to measure the 
actuator friction. 
Possible reasons: 

• The position sensor linkage is faulty or has become 
disconnected. 

• The friction of the actuator is too great for automatic 
tuning. 

• An external force is jamming the actuator. 

• The air supply failed during the test. 
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411 Actuator did not settle. The actuator did not settle correctly at the start of a tuning 
test. 
Possible reasons: 

• The actuator is too small for the system to control. 

• The air supply is unstable. 

416 Actuator did not settle. The actuator did not settle correctly at the start of a tuning 
test. 
 Possible reasons: 

• The actuator is too small for the system to control. 

• The air supply is unstable. 

422 Could not move actuator. 
 

The actuator could not be moved close enough to the start 
point of a tuning test. 
Possible reasons: 

• The actuator is too small for automatic tuning (tune 
manually). 

• The air supply failed during the test. 

426 Actuator failed to move. 
 

The actuator did not move during a tuning test. 
Possible reasons: 

• The actuator is too large/slow for automatic tuning. 

• The position sensor linkage is faulty or has become 
disconnected. 

• The air supply failed during the test. 

431 Actuator did not settle. 
 

The actuator did not settle during a tuning test. 
Possible reasons: 

• The actuator is too large/slow for automatic tuning. 

• The position sensor linkage is faulty or has become 
disconnected. 

• The actuator is too small for the system to control. 

• The air supply is unstable. 

432 Insufficient actuator movement. 
 

The actuator did not move enough during a tuning test. 
Possible reasons: 

• The actuator is single acting but the system is 
configured for double acting actuators. 

• The actuator is too large/slow for automatic tuning. 

• The air supply failed during the test. 

• An external force is jamming the actuator. 

441 Error calculating PID 
parameters. 
 

An error occurred while calculating the PID parameters.  
Please retry and if the problem repeats, contact your 
technical support  
representative.  As an interim solution, please manually 
choose appropriate PID tuning parameters. 

995 Unexpected software error. 
 

An unexpected software error occurred, please record the 
following and pass them to your customer support 
representative: 

• What type of actuator you are using. 

• Whether you have any boosters fitted in the supply 
lines. 

• The progress indicator value 

• Any other details about the application 
An un-trapped software error has occurred, and the system 
has reached an unexpected state. This probably indicates a 
software bug, so we need to get as much information about 
the application and fault as possible. 

996 Unexpected software error 
 

An unexpected software error occurred, please record the 
following and pass them to your customer support 
representative: 

• What type of actuator you are using. 
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• Whether you have any boosters fitted in the supply 
lines. 

• The progress indicator value 

• Any other details about the application 
An un-trapped software error has occurred, and the system 
has reached an unexpected state.  This probably indicates a 
software bug, so we need to get as much information about 
the application and fault as possible. 

997 Digital input triggered abort. 
 

The self tune procedure was aborted because a digital input 
was previously configured to put the valve into a safe state, 
and this digital input triggered during the sequence.  Please 
check the equipment connected to the digital inputs, to 
ensure that it will not fire during the self tuning, or 
alternatively, disable the digital input override setting in the 
control interface. 

998 Self tune aborted by user. 
 

The self tune was aborted at the request of the user.  Please 
restart the self tune when ready. 

999 Feature not implemented 
 

The self tuning procedure was attempted on a setup that the 
system is not currently capable of handling automatically.  
Please perform limits only tuning, and then tune the 
parameters manually. 
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